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About This Guide 
This guide provides detailed instructions regarding operations that can be performed in the 
SiteBuilder Wizard, a program that enables its users to create and publish websites on the 
Internet. 

Most topics of this guide are devoted to a particular task and the ways to perform it. This guide 
describes five main steps of a website creation, such as: 

1 Creating website design (see page 16)  

2 Creating and editing website structure (see page 18) 

3 Creating and editing website content (see page 21)  

4 Performing extra operations (see page 60) 

5 Publishing a website on the Internet (see page 66)  

Additionally, the guide describes the procedure of editing a website after it has been created and 
published on the Internet. Thus providing you with instructions about website update and 
maintenance. Information about editing published websites see in the After Publishing chapter 
(see page 67), later in this guide. 
 

Who Should Read This Guide 
The target audience of this guide are regular users of SiteBuilder as well as guests, who just 
work with SiteBuilder in guest mode and create trial websites without publishing them on the 
Internet. SiteBuilder users and guests do not need any special technical knowledge to use the 
SiteBuilder Wizard. The process of a website creation and its further publishing on the Internet 
is quick and easy. 
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Organization of This Guide 
Chapter 2, About SiteBuilder, describes the SiteBuilder interface elements, users, and first steps 
with the SiteBuilder Wizard. 

Chapter 3, Creating WebSite,  provides an outline of the way websites are created and edited, and 
gives the detailed instructions about creating a website using the SiteBuilder Wizard. 

Chapter 4, Publishing WebSite, contains instructions about how to publish your website. 

Chapter 5, After Publishing, tells how to edit and update your website after you have published it. 
 

Documentation Conventions 
Before you start using this guide, it is important to understand the documentation conventions 
used in it.  

Typographical Conventions 
The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information Example 

Special Bold Items you must select, such as 
menu options, command 
buttons, or items in a list. 

Go to the QoS tab. 

 Titles of chapters, sections, and 
subsections. 

Read the Basic Administration 
chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to designate 
a command line placeholder, 
which is to be replaced with a 
real name or value. 

The system supports the so called 
wildcard character search. 

Monospace The names of commands, files, 
and directories. 

The license file is located in the 
httpdocs/common/licens
es directory. 

Preformatted On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

# ls –al /files 
total 14470 

Preformatted Bold What you type, contrasted with 
on-screen computer output. 

# cd /root/rpms/php 

CAPITALS Names of keys on the keyboard. SHIFT, CTRL, ALT 
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KEY+KEY Key combinations for which the 
user must press and hold down 
one key and then press another. 

CTRL+P, ALT+F4 

 

 

 

 
 

Feedback 
If you spot a typo in this guide, or if you have thought of a way to make this guide better, we 
would love to hear from you! 

If you have a suggestion for improving the documentation (or any other relevant comments), try 
to be as specific as possible when formulating it. If you have found an error, please include the 
chapter/section/subsection name and some of the surrounding text so that we could find it 
easily. 

Please submit a report by e-mail to userdocs@swsoft.com. 
 

 

mailto:userdocs@swsoft.com
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About SiteBuilder 

SiteBuilder provides unique capabilities for you to create, publish, and maintain your websites 
without any knowledge of HTML or other programming languages. The SiteBuilder website 
content management solution enables wide groups of users to create their websites with 
minimum efforts.  

The SiteBuilder main benefits are the following: 

 Easy-to-use web interface implemented as a five-step point-and-click Wizard enables you to 
build and publish your websites following a simple straightforward scenario. 

 More than 500 high-quality templates with color variants offer rich opportunities for you to 
make your websites attractive and effective. 

 Powerful 'What You See Is What You Get' Editor (WYSIWYG Editor) enables you to see 
the entire page context while editing the contents. All changes on web pages can be tried 
and viewed before they are submitted.  

 Ten SiteBuilder modules add more functionality to your website pages, such as counters, 
bloggers, forums, guest books, and many others. Also, you can create specialized service 
pages, such as e-shops and photo galleries.  

 

In This Chapter 
Main Steps to Create Website ............................................................................................... 8 
SiteBuilder Users .................................................................................................................. 9 
Getting Started with SiteBuilder ........................................................................................... 10 
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Main Steps to Create Website 
As a rule, the process of creating a website includes three main stages: planning, 
implementation, and website updating or maintenance. 

Planning: The first and most essential stage in any project is planning. Before starting with 
SiteBuilder, think about the purpose of your website and its target audience. After this, decide 
where your website will be stored, or, in Internet terminology, hosted. This stage is beyond the 
scope of this document. We assume that if you have access to SiteBuilder, you have all 
resources required for website hosting. Then, you should develop a detailed structure of your 
future website and prepare its contents, including text information and graphics. The planning 
stage is extremely important because it eventually determines the usefulness of your website. 

Implementation: The next stage is the implementation of your website. The five-step SiteBuilder 
Wizard takes you through the entire procedure of creating your website, from initial design to 
publishing and maintenance. The following are the main steps required to create a website using 
SiteBuilder:  

1 Open the SiteBuilder Wizard. You can start working with the Wizard without user 
authorization (no login and password needed).  

2 Complete the first four Wizard steps. 

Open the Publish tab. At this step,you will see detailed instructions about how to access your 
new website so that you can edit it. Your website created using the SiteBuilder Wizard is saved 
as a trial site in a temporary storage directory on the SiteBuilder server. On the Publish tab, you 
will see an automatically generated site identifier. Using this link to the trial website, which 
might look like http://site_identifier.sitebuilder.hosting_provider.com, you can later return to 
your website, edit and publish it (about editing your website, see the After Publishing chapter 
(see page 67), later in this guide). Change the site identifier to some name you can easily 
remember (click Change My Site Identity).  

3 After you purchase hosting services from your provider, you will be provided with a domain 
name. Tell the SiteBuilder Administrator the domain name where your website will be 
hosted. The SiteBuilder Administrator will enter your domain name in the publish properties 
for your website in the SiteBuilder Administrator Panel. After publication, your website will 
be available on the Internet. 

4 Enter the link to your trial website in the address bar of the browser window. Your website 
will open in the browser window. Click Edit at the top of the website to launch the 
SiteBuilder Wizard. Now you can edit the content of your website. After editing, click 
Publish. The updated content of your website will be transferred to the server where your 
website is hosted. After publication, your website will be available on the Internet. 

Maintenance: When you complete the above steps, your website becomes available for visitors. 
It is critical to keep your website content fresh because this is a good way to show your attitude 
to customers and services. Therefore, always be sure that your website is updated on a regular 
basis.  

In SiteBuilder, it is easy to keep your website content up-to-date. All you need to do is to log 
into the SiteBuilder using the website identifier and your password, edit the content, and click 
Publish. SiteBuilder will automatically transfer the updated content to your hosting location. 

 

http://site_identifier.sitebuilder.hosting_provider.com/
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For detailed instructions about what you can do at every stage of creating your website, see the 
following chapters. 
 

SiteBuilder Users 
There are three types of users in SiteBuilder: Administrator, Reseller, and User.

1 User is a client who want to create and update websites using the SiteBuilder Wizard, which 
is a client part of the application. The SiteBuilder Wizard is an ideal tool for even non-
technical users to design their own websites. The Wizard has a WYSIWYG editor, a 
graphical interface process, which enables a user to view the end-result during a site 
creation. A WYSIWYG HTML (Hypertext Markup Language) editor generates an HTML 
markup but displays the document as it would be viewed with a web browser. The 
SiteBuilder Wizard can be used with programs such as photo gallery, e-shop, PayPal, blogs, 
voting, and much more. The Wizard also has an advanced internet statistics program that 
can generate twenty separate web statistics reports. To start working with the SiteBuilder 
Wizard, you do not need special accounts.  

2 Administrator is a user with administrator permissions who manages the SiteBuilder 
functionality and configures SiteBuilder settings for users through the Administrator Panel. 
SiteBuilder Administrator can perform a variety of management tasks, such as configure 
system parameters (database settings, language, licensing, and backup options), set up 
publishing options, manage websites, and define the components that will be available for 
users. Administrator also adds and manages Resellers accounts, that is adds allowed hosts 
and websites to Resellers accounts or disassociates hosts or websites from Resellers 
accounts. For more information about Administrator functionality, refer to the SiteBuilder 
2.1.3 for Unix Administrator's Guide (you can get it here 
(http://www.swsoft.com/en/products/sitebuilder2/docs/)). 

3 Reseller is SiteBuilder subadministrator who can sell website construction services to end-
users. Resellers manage websites of their customers, define plans for website construction 
services, and define the hosts on which users can publish their websites. Resellers work 
through the Administrator Panel. Resellers have their accounts (login and password) for 
logging into the Administrator Panel. For more information about Resellers and their 
functionality, refer to the SiteBuilder 2.1.3 for Unix Administrator's Guide. 

 
 

 

http://www.swsoft.com/en/products/sitebuilder2/docs/
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Getting Started with SiteBuilder 
This section describes your first steps with the SiteBuilder Wizard. 

In This Chapter 
Logging into SiteBuilder....................................................................................................... 10 
Starting to Work with SiteBuilder......................................................................................... 11 
Introducing SiteBuilder Wizard Interface ............................................................................. 13 
Getting Help.......................................................................................................................... 14 
 
 

Logging into SiteBuilder 
To log into the SiteBuilder Wizard for the first time and start creating your website 

1 Open your web browser. 

2 Enter the URL, that your SiteBuilder Administrator has given to you, into the address bar of 
your browser. For example, the URL can be  

http://sitebuilder.hosting_provider_domain.com/sitelogin.php

The SiteBuilder Wizard opens on the first Overview page.  

You can also access the SiteBuilder Wizard from the website of your hosting provider. 

Note: If you bought the SiteBuilder service as a part of Plesk hosting service, you can log into 

the SiteBuilder Wizard right from the Plesk control panel by clicking the SiteBuilder icon  
in the Domains section of the client interface. 
 

 

http://sitebuilder.hosting_provider_domain.com/sitelogin.php
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Starting to Work with SiteBuilder 
After you have logged into the SiteBuilder Wizard, you can overview the SiteBuilder 
functionality and select its interface language. The following picture displays the Overview page, 
where you can see short descriptions of five steps of the Wizard. 

 

Figure 1: Starting to Work with SiteBuilder 

The SiteBuilder steps are the following: 

 Design enables you to choose your website layout, color scheme, button style, a flash movie 
for the first page, and so on.  

 Pages enables you to create and edit your website structure. 
 Edit enables you to create and edit your website content. 
 Extra enables you to set up basic parameters for your website. 
 Publish enables you to publish your website to the server. 

To start creating your website  

 Click the Design tab at the top of the page. 
OR 

 Click Design in the main work area.  
OR 

 Click Next Step in the lower right corner of the page. 

To change the Wizard interface language, select the language you need from the Interface 
language list. 
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Note: If you use SiteBuilder for the first time, only two tabs are available at the beginning: 
Overview and Design. If you have already done something and stopped at some stage, click this 
stage to continue editing your website.  
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Introducing SiteBuilder Wizard Interface 
Typical SiteBuilder Wizard page is shown on the following picture. 

 

Figure 2: Introducing SiteBuilder Wizard Interface 

Every SiteBuilder Wizard page consists of the following elements: 

1 Logo is located in the top frame of the SiteBuilder Wizard. The default logotype is a 
SiteBuilder image linked to the SWsoft official website. This image can be customized by a 
SiteBuilder Administrator. 

2 Preview Website allows to preview a website at the every stage of website creation. 

3 Top help string provides short instructions about the operations you can do on this page. 

4 Work area displays the interface options available for the tab selected in the top frame. 

5 Tabs allow to switch between five Wizard steps. The tabs that are available for you at the 
current stage of creating a website are shown as active. For example, you cannot open the 
Edit tab until you have created a structure of web pages on the Pages tab.  

6 Help button opens HTML help topics, where you can easily find the information you need 
using the Contents and Index tabs.  

7 Logout button finishes the current session with the SiteBuilder Wizard. 

8 Help tips provide detailed instructions about what you can do on the screen you are currently 
on. 

9 Command bar at the bottom of the window displays the result of your last command.  

 



 About SiteBuilder 14 
 

10 Previous Step enables you to get to the previous step of the Wizard (you can also return to 
another step by selecting the corresponding tab in the top frame area). 

11 Next Step switches you to the next step of creating your website (you can also click the next 
tab in the top frame area).  

 
 

Getting Help 
The SiteBuilder help system has been created to assist you in solving problems you might 
encounter when creating your website. Finding answers on your own takes less time and is 
definitely more satisfying than any other way. To find the information you need, you can do the 
following: 

 Use on-screen context-sensitive help. It is the easiest and quickest way to get instant help 
with your immediate tasks. Using context-sensitive help will not interrupt your workflow. 
The Top help string contains short instructions about the operations that are available on the 
current page. If you need more information about available options, take a look at the help 
tips in the left frame. The Command bar at the bottom of the screen displays the result of the 
last command you have performed on the SiteBuilder page. 

 Read user documentation. To open the HTML version of the User's Guide, click Help at the 
top of any SiteBuilder page. Find the information you need using the Contents or Index tabs. 
If you prefer to read PDF documentation, download the files from the official SWsoft 
website at http://www.swsoft.com/en/products/sitebuilder/docs/ 
(http://www.swsoft.com/en/products/sitebuilder/win/docs/) . 

 FAQ. For the fastest way to solve problems, check out the SiteBuilder FAQ page 
(http://faq.swsoft.com (http://faq.swsoft.com)) that provides instant access to solutions for a 
variety of questions. Select the SiteBuilder category and view the list of FAQs related to 
SiteBuilder. 

 Online forum. If you failed to solve your problem using the ready-to-use FAQs, join our 
online forum at http://forum.swsoft.com/ (http://forum.swsoft.com/). Here, all users can post 
questions, exchange ideas, and troubleshoot common problems. However, this forum is an 
informal one. 

 Technical support. If you have any problems or questions that are not covered in the 
documents or online services, please contact SWsoft Technical Support 
(mailto:support@swsoft.com). 

 
 

 

http://www.swsoft.com/en/products/sitebuilder/docs/
http://www.swsoft.com/en/products/sitebuilder/win/docs/
http://faq.swsoft.com/
http://faq.swsoft.com/
http://forum.swsoft.com/
http://forum.swsoft.com/
mailto:support@swsoft.com
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Creating Website 

This chapter describes the steps of creating a fully featured website, starting from a website 
design to gathering website statistics.  

In This Chapter 
Creating Website Design....................................................................................................... 16 
Creating and Editing Website Structure................................................................................ 18 
Creating and Editing Website Content.................................................................................. 21 
Extra Features ....................................................................................................................... 60 
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Creating Website Design 
To create a design for your website, on the Overview page click the Design tab. The Design page 
opens. 

 

Figure 3: Creating Website Design 

 On the Design page, you can customize your website design using the following buttons in the 
navigation pane:  

 Layout enables you to define how separate elements, such as a company logo, head banner 
and navigation buttons, are arranged on web pages.  

 Color Scheme enables you to edit a website color scheme to make your website look more 
attractive and efficient. 

 Head Banner enables you to choose a head banner from the set of images available in the 
Wizard. You cannot use your own images as head banners. 

 Buttons enables you to choose a type of buttons, that is links used to navigate through 
website pages. 

 Logotype enables you to replace SiteBuilder logo with your own and re-brand SiteBuilder 
using it. 

 Flash Intro adds more visualization to your website. Flash intro is a short flash movie played 
on the introductory page. 

 Info enables you to enter information about your company and website, such as the company 
name, copyright, URL to the corporate website, and the slogan. 
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To create a design for your website 

1 Click Layouts in the navigation pane to select a layout for your website. Click Preview under 
a layout to view its enlarged image. Click Select Layout or the layout image to select the 
layout. 

SiteBuilder offers an extensive set of layouts so that you can select the one that best fits 
your needs. You can browse layouts by categories or may prefer to browse all available 
layouts. To browse layouts by category, select the desired category in the Category list at the 
bottom of the page. To view all available layouts, select All categories in this list. 

To preview your future website, click Preview Website at the top of the navigation pane. In 
the preview mode, you can see how your website (with current contents and settings) will 
look in a web browser window. 

2 Click Color Scheme in the navigation pane to define a color scheme for the selected layout. 
Click Select Color to apply the desired color scheme to the selected layout.  

3 Click Head Banner in the navigation pane to change the default head banner image. Select 
the image you like and click it. To view an enlarged image, click Preview. 

4 Select Buttons in the navigation pane to customize the design of buttons used to navigate 
through website pages. Select the button design you like and click Select Button. 

5 Click Logotype in the navigation pane to upload a logotype of your company to the website. 
In the New logo field enter the full path to the logo image file (a .gif or .jpeg file). The 
recommended size of the logo image depends on the selected template. 

6 Click Flash Intro in the navigation pane to insert a short flash movie that will be played on 
the introductory web page. On the page that opens, select a flash movie.  

Select Enable Flash Intro to play the selected flash movie on the introductory page of your 
website. In the fields below, enter the heading and body text for the selected flash movie. 
Select the color for the flash and objects used on the flash movie from the Background 
scheme and Object scheme lists. Click Apply. 

7 Click Info in the navigation pane to place the company name, slogan, URL, and copyright 
on your website (all these elements are optional and depend on the selected template). 
Provide the required information in the corresponding fields and click Apply. 

After the general design is ready, you can move to the next step. Click Next Step or the Pages 
tab to define the structure and pages for your future website.  
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Creating and Editing Website Structure 
A website consists of several pages linked together in an organized way to present information 
in an ordered way. Using SiteBuilder, you can arrange the pages in two levels of hierarchy - 
top-level pages and second-level pages. Therefore, you must clearly understand how you intend 
to structure your website.  

You can add three types of pages to your website: 

 HTML pages use only HTML (HyperText Markup Language) code to present information. 
 Photo gallery pages provide a convenient way to store and organize your pictures on the 

website (this type is optional; it depends on your business plan) 
 Shop pages offer website visitors an opportunity to purchase your products online (this type 

is optional, it depends on your business plan). 

Note: The maximum number of top-level and second-level pages you can create using 
SiteBuilder is 60 (6 top-level pages and 10 second-level pages). This is the limit of the 
SiteBuilder application. In addition, the total number of pages you can add is also limited by the 
business plan defined either by the SiteBuilder Administrator or a Reseller. In the figure below, 
the maximum number of pages allowed by the business plan is 10 (see this message in the 
navigation pane on the Pages page). If you want to add more pages than allowed by your plan, 
please contact the SiteBuilder Administrator or Reseller. 

To facilitate working with SiteBuilder, HTML pages are grouped as pre-defined sets of pages, 
which are different for various types of websites (business, personal, or other). Depending on 
the purpose and functionality of your future website, you can use a ready-to-use page set and 
modify it to adjust the structure of your website to your needs. 

To edit a website structure, click the Pages tab. The Pages page opens. 
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Figure 4: Creating and Editing Website Structure 

To add pages to your website and organize them in a hierarchical structure 

1 Select a type of your future website from the Type list. A set of pages for the selected type 
appears in the Available pages box. 

2 From the Available pages box, choose the pages that you want to add to your website by 
selecting the corresponding check boxes.  

3 Click Add Selected Page(s) to add the selected pages to your website structure.  

4 Edit your website structure using the buttons next to the Your site structure box. 

 To add a new page to the website structure, click Add New Page. An additional screen 
appears (in the following picture this screen is gray). Select the type of the page (HTML 
page, Photogallery page, or Shop page) from the Type list and type the title for the new 
page in the Title field. 
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Figure 5: Adding New Page 

 To edit a page title, select the page in the Available pages box, click Edit Page Title, and 
type the new name in the Title field. 

 To delete a page, select it in the Your site structure box and click Delete Page(s). 
 To move a page up or down at the same level, select it in the Your site structure box and 

click Move Page Up or Move Page Down respectively.  

 To move a page from the second level to the top level, select it in the Your site structure 
box and click Move Page to Upper Level.  

 To move a page from the top level to the second level in the structure, select it in the 
Your site structure box and click Move Page to Lower Level. Pages at the second level are 
marked with "..." before their titles. 

5 To preview the current version of your website, click Preview Website in the top left corner 
of the window.  

Note: You can preview the website at any stage of its creation. 

When you finish working with the website structure, click the Edit tab. You will be asked to 
save changes to the website structure. Click OK to move to the Edit tab.  
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Creating and Editing Website Content 
The SiteBuilder application is empowered with a user-friendly WYSIWYG content editor, 
which enables you to see the content on the display screen exactly as it will appear on the 
Internet. The SiteBuilder editor is organized in such a way that the text you type on pages and 
the design of pages are independent. Therefore, you can completely change the design for a 
page after you have typed a text on this page. You will not have to retype the text. 

To create and edit your website content, click the Edit tab. The Edit page opens. 

 

Figure 6: Creating and Editing Website Content 

The interface of the SiteBuilder editor is familiar to users who have had a previous experience 
with the Microsoft Office application bundle. The editor main window consists of the following 
parts: 

1 Editor toolbar provides access to commands used to edit textual information. 

 

Figure 7: Editor toolbar 

2 Modules toolbar contains modules icons used to insert modules into HTML pages. 

 

Figure 8: Modules toolbar 
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3 Work area, where you can add and edit the contents of your website. To navigate to different 
pages of your website, click the corresponding links.  

4 Advanced toolbar enables you to view and edit the HTML structure of the part of text where 
your mouse cursor is on. 

If the default size of the editor window is too small for you, click Full screen  to enlarge the 
editor window to the full screen. To return to the smaller SiteBuilder screen, click Normal 
screen . 

To save the changes you have made while editing the content, click Save changes . 
 

Editing Textual Information on Web Pages 
This subsection tells how to work with textual information on your web pages. You will know 
how to format characters and paragraphs, cut, copy, paste text, insert images and links. 
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Formatting Characters 

Using the Editor  toolbar, you can change the following parameters: 

 Font 
 Size 
 Style 
 Color 
 Font Settings 
 Symbols 

 

Figure 9: Formatting Characters toolbar 

To apply formatting to a text 

1 Go to the Edit page and choose the web page where you want to edit the text. 

2 Place your mouse cursor on any place on this page and type your text. 

3 Select the portion of the text you want to change (even one character will suffice). 

4 Select a font you like from the Font list. 

5 Select the needed font size from the Size list. 

6 Select the appropriate style from the Style list. 

7 Click Font color   to choose the font color. 

8 Click Background color   to choose the background color. 

9 Click Bold , Italic , Underline , or Strikethrough  to make the text bold, italic, 
underlined, or strikethrough respectively. 

10 Click Subscript  or Superscript  to make the text subscript or superscript respectively. 

11 Click Insert symbol   to insert special symbols into the text, such as copyright character, 
letters of other alphabets, and other signs. 

Note: Use styles to apply a particular format to the selected text. This ensures that similar pieces 
of text are formatted in the same way, thus maintaining consistency throughout your website.  
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Formatting Paragraphs 

Paragraph indentation and alignment are the main parameters that define the position of a 
paragraph on a page. Indentation determines the distance of the paragraph from the left margin 
of the page. Alignment determines the orientation of paragraph edges. 

Using the SiteBuilder Editor toolbar, you can do the following: 

 Increase or decrease the indentation of a paragraph.  
 Make a paragraph left-aligned, center-aligned, right-aligned, or justified. In case of justified 

alignment, the text is spread evenly between the left and right margins of the page.  
 Visually separate the logical parts of textual information using horizontal rules. 

To apply formatting to a paragraph 

1 Select the text which you want to format. 

2 Apply the following formatting commands: 

 To align the text, click Justify left ,  Justify center ,  Justify right , or Full justify 
 on the toolbar. 

 To change the indentation of the selected text, click Increase indent  or  Decrease 
indent  on the toolbar. 

 To insert a horizontal rule, place a cursor in any place on the page and click Horizontal 
rule  to insert the rule. 
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General Commands 

Using the SiteBuilder Editor toolbar, you can do the following: 

 Move or copy text and graphics 
 Undo or redo the last action you have made 
 Search and replace text 
 Check spelling 
 Select the entire text of a page 

To move or copy text or graphics 

1 Select the needed item. 

2 Do one of the following: 

 To move the item, click  Cut . 

 To copy the item, click Copy . 

3 Click where you want the item to appear. 

4 Click Paste . 

To undo the last action, click Undo . If you later decide that you do not want to undo the last 
action, click Redo  . 

To search a word or phrase 

1 Click Find . The Find and Replace dialog box opens.  

 

Figure 10: Searching text 

2 In the Find what field, enter the text you want to search for. 

3 Click Find. 

You can automatically replace text, for example, you can replace "piple" with "papal". To 
replace text 

1 Click Find . The Find and Replace dialog box opens. 

2 In the Find what field, enter the text you want to replace. 

3 In the Replace with field, enter the replacement text. 

4 Click Replace or Replace All. 

To check spelling on the page 
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1 Click Check Spelling  (for English language). The Check Spelling dialog box opens. 

 

Figure 11: Checking Spelling 

2 In the Not in dictionary field, a possible spelling mistake is shown.  

3 If you are sure that the word found by the Check Spelling editor is not misspelled, click 
Ignore or Ignore All.  

4 If you want to replace the misspelled word, type the replacement word in the Change to 
field and click Replace or Replace All. 

To select the entire text on the page, click Select All . 
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Inserting Images 

Using the SiteBuilder Editor toolbar, you can insert any images into web pages.  

To insert an image 

1 Click where you want to insert a picture. 

2 Click Insert/Modify Image . The Insert/Modify Image dialog box opens. 

 

Figure 12: Inserting Image 

Note: You can insert a picture either from the website gallery or from a local computer. The 
website gallery contains images that are already used on your web pages. By default, the 
website gallery is empty. You have to upload files to the website gallery to be able to reuse 
them later on pages. 

3 If the website gallery contains some pictures, click Select. You will see the Image Navigator 
dialog box that displays all pictures stored in the website gallery. Select a picture and click 
OK. 
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Figure 13: Image Navigator 

If the website gallery is empty, click Browse to upload a picture from your local computer. 
Navigate to the target file on your hard disk. Click Upload to add the selected image to the 
website gallery.  

4 In the Layout group, select from the Alignment list position for the picture to define how the 
picture will be aligned on the page: left, right, atop of the text, and so on. In the Border 
thickness field, enter the number of pixels for the border around the picture. The default 
value 0 means that the picture will not be bordered. 

5 In the Spacing group, define the indentation of the picture. Enter the number of pixels for 
indentation into the Horizontal and Vertical fields respectively. 

6 In the Alternate text field, enter a short description of the picture that will be displayed for 
those users who are unable to view pictures in their browsers (if, for example, the Show 
pictures option is disabled in browser options). Instead of pictures, the respective alternate 
texts will be output. 

You can preview the image in the Preview box. 

7 Click OK. The picture appears on your page. 

To resize a picture, click it on the web page. Small squares appear around its perimeter. Click 
one of them and drag the mouse to resize the image.  

To move a picture to another location on the page, click it and drag it to the new location and 
then release the mouse. 

To edit picture properties, double click it to open the Insert/Modify Image dialog box where you 
can modify the above-described properties. 
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Inserting Links 

Using SiteBuilder, you can insert both internal and external links. Internal links point to other 
places of your website, taking the reader to related pages. External links pointing to other 
websites are often used to improve your website popularity and increase your website visitor 
traffic (the so-called link exchange).  

To insert a link 

1 Click Insert web link . The Insert/Modify Link dialog box opens. 

 

Figure 14: Inserting Link 

2 To insert an external link pointing to another website 

 Enter the website address (URL) in the URL field, for example, www.swsoft.com.  

 Enter the name for this link as it will be displayed on the page in the Text field. 

3 To insert an internal link pointing to other pages of your website 

 Select the page you want the link to point from the To pages in this site list.  

 Enter the name for this link as it will be displayed on the page in the Title field. 

4 From the Target list, select how the link will open: in a new browser window or in the same 
window. Usually, internal links open in the same browser window, whereas external links 
open in a new window. 

5 From the Text decoration list, select how the link will appear on the page: underlined, 
overlined, or with strikethrough formatting. If you select None, the link will not be 
distinguished from the context. As a rule, links are underlined. 

6 Click OK to insert the link. 

To edit an existing link, double click it on the page. The Insert/Modify dialog box opens where 
you can change the above-described settings. 
 

Working with Tables 
This section describes how to work with tables. You will know how to insert tables, add and 
delete rows, columns and cells, merge and split cells, drag tables. 
 

 

http://www.swsoft.com/
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Inserting Tables 

Tables are used to organize textual and numerical information in a convenient and clear way. 
They represent even large amounts of textual information in an easy-to-read format. Tables 
consist of grids formed by rows and columns. On web pages, tables are often used as a 
formatting tool to maintain the size and proportion of page borders in all browsers and output 
formats. Borders can be made invisible and information in a table appears as formatted in a 
desired way. For example, this can be useful when organizing the text in several columns, like 
in a newspaper.

To insert a table 

1 Place the cursor where you want to insert a table. 

2 Click Insert/Modify Table . The Insert/Modify Table dialog box appears. 

 

Figure 15: Inserting Table 

3 In the Rows and Cols fields, enter the desired number of rows and columns for the new 
table.  

4 In the Width field you can determine how much space the new table will occupy on the 
screen. Select the measurement unit from the list next to the Width field (percent, pixels, or 
points) and enter the value. 

5 From the Alignment list, select how the table will be aligned: to the left, center, or right of 
the web page.  

6 In the Border thickness field, enter the width of the table borders (in pixels). Enter 0 to make 
them invisible. 

7 In the Cell spacing field, enter the number of pixels to specify the space between the cells of 
the table. This value can be used to create margins within the text. 

8 In the Cell padding field, enter the number of pixels to set spacing between the boundary of 
the cell and the text inside the cell.  

9 Click OK.  

The new table appears on the web page. Click in a table cell to type the information. 

You can edit table properties, such as border width, cell spacing, and the width of an existing 
table. 

To edit table properties 
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1 Double click the table on the web page.  

2 In the Insert/Modify Table dialog box, change the layout, spacing, and width options for this 
table (the number of rows and columns cannot be changed).  

Click OK to save the changes. 
 

Adding Rows, Columns, and Cells 

After the table is inserted, the icons related to table formatting become active on the SiteBuilder 
Editor toolbar.  

 

Figure 16: Table Editing toolbar 

To add rows, columns, or cells to a table 

1 Place the cursor in the table where you want to add a new row, column, or cell. 

2 Click one of the following icons: 

 Insert row before  or Insert row after  to insert a row above or under the cursor 
respectively. 

 Insert column before  or Insert row after  to insert a column to the left or to the 
right of the cursor respectively. 

 Insert cell before  or Insert cell after  to add a cell above or under the cursor 
respectively. 

 
 

Deleting Rows, Columns, and Cells 

When working with a table, you may need to delete unnecessary rows, columns, or cells.  

To delete rows, columns, or cells from a table 

1 Place the cursor in a row, column, or cell that you want to delete (you can delete only one 
element at a time) 

2 Click one of the following icons: 

 Delete row  to delete a row.  

 Delete column  to delete a column.  

 Delete cell  to delete a cell (the cells will be shifted to the left). 
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Merging Cells 

You can merge neighboring cells so that they form a single cell. Multiple cells can be merged 
either vertically or horizontally. 

To merge cells in a table 

1 Place the cursor in the cell you want to merge with other cells. 

2 Click Merge cell  . The Merge Cells dialog box opens. 

 

Figure 17: Merge Cells dialog box 

3 In the Cells field, enter the number of cells you want to merge. 

4 From the Merge list, select the merging direction starting from the current cursor position. 

5 Click OK. 

 
 

Splitting Cells 

You can split a cell in a table into two equal cells or split a merged cell into the original number 
of rows and columns. 

To split a single cell into two equal cells (that was not merged before) 

1 Place the cursor in the cell you want to split. 

2 Click Split cell   to split the current cell (where the cursor stands) into two equal cells. 

To split merged cells into rows or columns 

1 Place the cursor in the cell merged downwards. 

2 Click Split row  or Split column  to split the current cells into rows or columns. 
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Dragging Tables 

You can move a table all along the web page using a simple drag-and-drop operation. 

To move a table 

1 Point the mouse cursor at a table.  

2 Drag the table to the desired location and drop it.  

 

Figure 18: Dragging Tables 
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Using SiteBuilder Modules 
SiteBuilder has the following modules (the Administrator or Reseller determines which modules 
are available for you in accordance with the selected Plan): 

 Votes Editor 
 Blogger Editor 
 Counter 
 Feedback Forms Constructor 
 Forum Editor 
 Guestbook Editor 
 RSS Reader 

Script Editor The most general rules for working with all SiteBuilder modules: 

 The modules icons are located on the Modules toolbar of the Edit tab. To insert the desired 
module, simply click one of the icons. 

 

Figure 19: Modules toolbar 

 You can add any number of modules on each page. 
 The modules cannot be viewed directly on the Edit page. You can see only white rectangles 

representing modules. To preview the modules as they will be displayed in browser 
windows, click Preview Website. Your website will open in a new browser window with all 
elements displayed. 

 Modules can be resized on the Edit page main window. To change the size of a module, 
click on the module rectangle so that sizing handles appear (sizing handles are the small 
circles or squares that appear in the corners and on the sides of selected objects). Drag the 
sizing handle until the module is the size you want. 

To delete a module from the page, click the module on the Edit page main window and press 
DELETE or click  on the Modules toolbar. 
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Inserting Votes 

Votes modules enables you to conduct online polls and surveys, thus receiving valuable 
feedback from your customers. They can be used to collect information about the website 
audience, potential clients, products and services, and carry out marketing polls.  

Using the SiteBuilder Votes Editor, you can collect votes on different questions and display the 
results as dynamic graphical charts directly on the page. The SiteBuilder voting module tracks 
visitor uniqueness based on the single session principle, that is a visitor cannot vote several 
times in this poll within the same session (until he or she restarts the browser). 

To insert and configure the Votes module 

1 On the Modules toolbar, click Votes Editor . A white rectangle representing the module 
appears on the web page. To configure the module, double click the module rectangle on the 
web page. The Votes Editor screen opens. 

 

Figure 20: Configuring Votes Module Properties 

2 On the Properties tab, do the following: 

 Enter the question you want to ask your visitors in the Question field. 

 Type the answers in the Answer fields and select the check boxes next to these fields. 
Provide at least two answer options. 

 To provide more than two answers, click  Add Answer. The additional Answer field 
appears. 

3 On the Design tab, do the following: 

 Select a design template and the design of bars that will graphically represent polling 
results on the page. 

 Define whether users can select several answers or only one answer by selecting the 
Multi select or Single select radio buttons. 

 Select the Show borders check box to display borders around the voting module. 
Otherwise, clear this check box. 
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Figure 21: Selecting Votes Module Design 

4 On the Preview tab, you can view how the module will look on your page. On the Preview 
tab, you can try to give an answer. 

5 Click Apply. 
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Creating Blogs 

Blog is short for weblog. A weblog is a web journal that is used as a publicly accessible 
personal diary or journal of an individual. Usually, blogs are frequently updated and reflect the 
personality of the author (a good example of blogs is the so-called live journals). Using the 
SiteBuilder Wizard, you can insert a blog on your web page. 

To insert and configure the Blogger module 

1 Click Blogger Editor . A white rectangle representing the module appears on the web 
page. To configure the Blog module settings, double click the module rectangle on the web 
page. The Blogger Editor screen opens. 

 

Figure 22: Configuring Blogger Module Properties 

2 On the User Options tab, do the following: 

 Enter the blog name as it will be used by a Blogger API-based application. 

 In the Login field, enter the user login used to authorize a blog user to add, edit and 
remove posts either through the web interface or using Blogger API. 

 In the Password field, specify the password and type it again in the Password 
confirmation field. Password and the user login are required for user identification. 
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 In the First name and Last name fields, enter your first and last names that will be 
transferred to the program that uses Blogger API. If the names are not specified, the 
program will not provide the first and last names of the blog owner. 

 In the E-mail field, enter the e-mail that will be transferred to the program that uses 
Blogger API. If the e-mail is not specified, the program will not provide the e-mail of 
the blog owner. 

 In the URL field, enter the URL that will be used to open the blog in the browser window 
through the program using Blogger API. 

3 On the Preview tab, you can preview your blog as it will appear on your website. Click 
Login on the Preview page and enter the login name and password you specified on the User 
Options tab. Here you can try to post new messages, edit them, and add your comments.  

4 Click Apply. 
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Inserting Counters 

Counters track and display the number of unique visitors at your website during one day. 

To insert and configure the Counter module 

1 Click Counter Editor . A rectangle representing the module appears on the web page. To 
configure the Counter module settings, double click the module rectangle on the web page. 
The Counter Editor screen opens. 

 

Figure 23: Configuring Counter Module Properties 

2 On the Properties tab, do the following: 

 Select the design of the counter. 

 In the Reset counter radio group, choose whether or not you want to reset counter to its 
initial position by selecting corresponding radio button (Yes or No). 

 In the Counter start field, enter the minimal number of visitors the counter must start 
working from. 

3 On the Preview tab, you can preview the counter as it will be displayed on your web page. 

4 Click Apply. 
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Constructing Feedback Forms 

Online feedback forms are used to create registration forms and send this information to the 
specified e-mail address. With the SiteBuilder Feedback Form Constructor, you can insert an 
online registration form on the web page to collect contact information about your visitors. 

To insert a feedback form in your web page 

1 Click Feedback Editor . A white rectangle representing the module appears on the web 
page. To configure the Feedback Forms module, double click the module rectangle on the 
web page. The Feedback Forms Editor dialog box opens. 

 

Figure 24: Configuring Feedback Forms Module Properties 

2 On the Properties tab, do the following: 

 Enter the title for your form in the Feedback form name field. The title should 
correspond to the purpose of this form, for example, Contact Information. 

 In the E-mail address field, enter the e-mail address to where the filled in forms will be 
sent. In the E-mail subject field, enter the subject for this e-mail message. 

 In the Response text field, type the text that will be displayed on the page after a visitor 
fills in the form.  

3 On the Fields tab, select the fields that will be included in the feedback form. If you want to 
make a field mandatory for filling in, select the Required field check box on the right of the 
corresponding field. 
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Figure 25: Setting Required Fields 

4 On the Preview tab, you can preview the feedback form as it will appear on your website. 
Here you can try to fill in the form fields. After you submit the trial form, check that you 
have received the answers at the e-mail box you specified on the Properties tab. 

5 Click Apply. 
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Creating Forums 

To improve the quality of your services and know the opinion of your customers and visitors on 
different matters, you can provide an online forum on your web page. Online forums are web-
based message boards where visitors can open new topics, post topic-relevant messages, and 
discuss a wide range of questions. Using the SiteBuilder Forum Editor, you can configure and 
set up an online forum in a few clicks. 

To insert and configure the Forum module 

1 Click Forum Editor . A white rectangle representing the module appears on the web page. 
To configure the Forum module, double click the module rectangle on the web page. The 
Forum Editor screen opens. 

 

Figure 26: Selecting Forum Design 

2 On the Design page, select the design template for your forum. To preview the selected 
template, open the Preview tab. 

3 On the Properties tab, do the following: 

 Select the number of months during which messages will be stored in the forum from 
the Message lifetime list. 

 Select the number of messages displayed on each page of the forum from the Messages 
per page list. 

 Select the optimal width (in pixels) for your forum to fit better between page margins 
from the Module width list.  
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Figure 27: Configuring Forum Modules Properties 

4 On the Preview tab, you can preview your online forum as it will appear on your website. 
Here you can try to create topics and submit answers.  

 

Figure 28: Previewing Forum Module 

5 Click Apply. 
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Creating Guestbooks 

On a guestbook page, your visitors will be able to leave their notes, messages, and comments. 
The main difference between guestbooks and online forums is that in forums, all messages are 
grouped in threads, or topics. In guestbooks, all messages are displayed in the order they were 
submitted. The SiteBuilder Guestbook Editor enables you to easily insert a guestbook in your 
HTML page. 

To insert a guestbook on the page 

1 Click Guestbook Editor . A white rectangle representing the module appears on the web 
page. To configure the Guestbook module, double click the module rectangle on the web 
page. The Guestbook Editor screen opens. 

 

Figure 29: Selecting Guestbook Design 

2 On the Design page, select a design template for your guestbook. To preview the selected 
template, open the Preview tab. 

3 On the Properties tab, do the following: 

 Select the number of months messages will be stored in the guestbook for from the 
Message lifetime list. 

 Select the number of messages displayed on each page of the guestbook from the 
Messages per page list. 

 Select the optimal width (in pixels) for your guestbook to fit better on the page from the 
Module width list. 
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Figure 30: Configuring Guestbook Module Properties 

4 On the Preview tab, you can preview your guestbook as it will appear on your website. Here 
you can try to send messages.  

 

Figure 31: Previewing Guestbook Module 

5 Click Apply.  
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Importing News from RSS Channels 

RSS, which stands for Really Simple Syndication, enables webmasters to automatically load 
favorite news and information about private websites from RSS news feeds (also called 
"channels"). Many well-known news communities and corporate websites offer news headlines 
and article summaries in the form of news channels. RSS readers retrieve the recent content 
from the RSS news feeds and display it on your website. Visitors can preview the recent news 
content from your website and will be redirected to the news page if they want to read the full 
story. The news from RSS channels are updated automatically, required no interaction from 
your part.  

Using the RSS Reader integrated with SiteBuilder, you can easily add your favorite news from 
either well-known RSS news feeds or from your own RSS news channel to your website. 

To add and configure the RSS Reader module 

1 Click RSS Reader Editor . A white rectangle representing the module appears on the web 
page. To configure the RSS Reader module, double click the module rectangle on the web 
page. The RSS Reader Editor screen opens. 

 

Figure 32: Selecting RSS Channel 

2 On the RSS Channels List tab, select the RSS channel from where you want to fetch the 
news. 

Note: The RSS reader integrated with SiteBuilder enables you to select only one RSS 
channel. 

3 If you want to add news from an RSS channel that is not in the list, click the Own RSS 
Channel Subscription tab and enter the URL of this RSS channel. 

4 Return to the RSS Channels List tab and select the Own RSS channel radio button. 

5 On the Preview tab, you can preview the news fetched from the selected RSS channel as 
they will appear on your website.  

6 Click Apply.  
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Using Script Editor 

Using the SiteBuilder Script module, you can add your own Java Script, HTML, and DHTML 
code to your web pages. 

Important: To protect the SiteBuilder server from possible security breaches, you cannot add 
the scripts that are executed on the server side, for example, PHP, CGI, or ASP code.  

To insert HTML or JavaScript code on your web page 

1 Click Script Editor . A white rectangle representing the module appears on the web page. 
To enter the script, double click the module rectangle on the web page. The Script Editor 
screen opens. 

 

Figure 33: Using Script Editor 

2 On the Script Text tab, type in the script. 

3 On the Preview tab, you can preview the web page with the script you have just entered.  

4 Click Apply. 
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Editing Photo Gallery 

Using SiteBuilder, you can add photo gallery pages to your website, which are optimized for 
presentation of photographs. Information about adding photo gallery pages see in the Creating 
and Editing Website Structure section (see page 18), earlier in this guide. 

To add photos to the photo gallery 

1 On the Edit page, navigate to the photo gallery page using the menu buttons of your website.  

2 On the photo gallery page, double click the photo gallery module rectangle. The Photo 
Gallery Editor screen opens. 

 

Figure 34: Configuring Photo Gallery Properties 

3 On the Photo Management tab, do the following: 

 Click Browse to locate the file with the picture that you want to add to the gallery. 

 Enter a caption for this picture in the Image caption field. 

 Click Add Image. The picture thumbnail and its caption appear in the list below Add 
Image. You can add any number of photographs to the photo gallery. 

 To remove images from the list on the Photo Management tab, select the corresponding 
check box in the Delete column and click Delete Image(s). 

4 On the Template Selection tab, select the design template for your photo gallery.  

5 On the Preview tab, you can preview your photo gallery as it will appear on your website.  

6 Click Apply. 
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Creating Your E-Shop 

Using the SiteBuilder E-Shop Editor, you can easily create, operate, and maintain your own 
professional-looking online store in less than an hour. To create a professional and profitable 
ecommerce store, you do not need any programming or website design skills. 

You, as an e-shop owner, can create categories of products, add products to the categories, and 
manage users who will be able to purchase the products online. Customers browse your e-shop, 
add products to their shopping carts, and submit their orders. They register at the store online so 
that they can later return to their shopping carts and continue shopping. Your ecommerce 
resource can be integrated with the PayPal payment processing system so that customers can 
pay for their purchases using their credit cards. If you do not want to accept credit card 
payments, the orders made through your online store will be saved in the E-shop Management 
System, from where you can view customers' contact information and handle orders. The 
sections below describe in detail how to create and manage a fully-functional web-based online 
store. 

The procedure of adding e-shop pages to your website is described in the Creating and Editing 
Website Structure section (see page 18), earlier in this guide. 
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Creating E-Shop Design 
After the e-shop page is added, you can select the design and configure e-shop administration 
settings. 

To select the design and configure settings for your online store 

1 On the Edit page, navigate to the e-shop page using the menu buttons of your website.  

2 On the e-shop page, double click the e-shop module rectangle. The Shop Editor screen 
opens. 

 

Figure 35: Creating E-Shop Design 

3 On the Design tab, do the following: 

 Enter the currency used as a payment unit at your store in the Monetary unit field. 

 Using the radio buttons below, select the location for the monetary unit symbol: Before 
the price or After it. 
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 Select a graphical template for your e-shop: for the product category catalogue and for 
the product lists. 

 Enter the number of categories displayed per page in the Product categories per page 
field. The default value is 6 categories. 

 Specify the number of products displayed on e-shop pages in the Products per page 
field. 

 Specify the height and width of the preview image for shopping categories (in pixels) in 
the Category image preview height and Category image preview width fields. The default 
height is 100 pixels and the default width is 70 pixels. 

 Enter the height and width of the preview image for products (in pixels) in the Product 
image preview height and Product image preview width fields. The default height is 100 
pixels and the default width is 70 pixels. 

After you have set the design options, go to the Categories tab to add new categories of 
products. 
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Adding Categories and Products 
To load your online store with goods, you first need to create categories. Then, add products and 
their pictures to the existing categories. 

To add categories 

1 On the Shop Editor screen, open the Categories tab. The list of categories is empty at the 
beginning. Click Add Category. 

 

Figure 36: Adding Categories 

2 Enter a name of the category in the Category name field (for example, home appliances).  

3 Enter the path to the image for this category in the Category image field or click Browse to 
locate it. You can add images of any size because SiteBuilder automatically resizes them to 
fit the maximum size specified on the Design tab. 

4 Click Apply.  

You can add more categories following the procedure described above. 

To add products to the categories 

1 On the Products tab, click Add Product (unless you add at least one category, the Products 
tab is unavailable). 
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Figure 37: Adding Products 

2 Select a category for the product from the Product category list (for example, home 
appliances). 

3 Enter a name of the product in the Product name field (for example, toaster). 

4 Specify the product price in the currency units you specified on the Settings tab in the Price 
field. 

5 Enter the path to the image of this product in the Product image field or click Browse to 
locate it. You can add images of any size because SiteBuilder will automatically resize them 
to fit the maximum size specified on the Design tab. 

6 Enter a short description of the product that will be displayed on the Products Category page 
in the Brief product description text box. 

7 Type a full description of the product displayed on the product page in the Product 
description text box. 

8 Click Apply. 

You can add more products to the store following the procedure described above. 

After you have created categories and added products, go to the Mail Parameters tab, to 
configure e-shop mail settings. 
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Configuring Mail Parameters 
To configure your e-shop mail settings 

1 On the Shop Editor screen, open the Mail Parameters tab. 

 

Figure 38: Configuring E-Shop Mail Parameters 

2 Specify settings of the e-mail notification sent to users after they have registered at your 
online store: 

 Enter an e-mail address from which the notification e-mail will be sent in the From e-
mail address field. If you leave this field empty, the e-mail will be sent from the default 
address of the SiteBuilder server. 

 Enter a subject of this notification e-mail message in the Sign up e-mail subject field. 

 Enter the text of the notification e-mail sent upon registration at your shop In the Sign up 
e-mail message field. 

3 Specify settings of the e-mail sent to the customers if they forget the password for the 
account: 

 Enter a subject of this e-mail message in the Forget password e-mail subject field. 

 Enter a text of the e-mail message sent to the users when they forget their password in 
the Forget password e-mail message. 

4 Specify settings of the e-mail sent to the customers after they submitted the order:  

 Enter a subject of the e-mail notifying the user about the order in the Order e-mail 
subject field. 

 Enter a message text notifying users about their orders in the Order e-mail message field. 

After you have set all the parameters, go to the PayPal tab to integrate your e-shop with the 
PayPal payment system. 
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Integration with PayPal 
To accept payments online, you can integrate the PayPal payment processing system into your 
online store. Online shoppers will be able to pay for their purchases using credit cards directly 
from your web page. 

If you, as a store owner, want to accept credit card and bank account payments from shoppers, 
use the integrated PayPal payment system at your online store. For this, you should have a 
merchant account at PayPal. Therefore, register at PayPal. On the official PayPal website 
(http://www.paypal.com/), you can find more information about PayPal services for online store 
owners. 

To integrate your e-store with the PayPal payment system 

1 On the Shop Editor screen, open the PayPal tab. 

 

Figure 39: Configuring PayPal Properties 

2 Enter the e-mail of your PayPal account in the PayPal e-mail field (in PayPal, all accounts 
are attached to e-mails). 

3 Select a currency unit for payments through PayPal from the PayPal currency of the payment 
list. 

4 If you want to charge a fee for handling PayPal-based orders, in the PayPal handling field, 
enter a fixed fee that will be charged for processing a single order. This fee does not depend 
on the number of goods in the shopping cart. The specified sum will be added to the total 
sum of the shopping cart. If no sum is entered, the fee for handling orders will not be 
charged. 

5 Specify the shipping rates for shipping goods purchased by customers: 

 

http://www.paypal.com/
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 In the PayPal tax field, specify the amount of taxes applied to the transaction, regardless 
of the buyer location. The value in this field overrides other tax settings in your PayPal 
Profile. If you leave this field blank, the tax rates specified in your PayPal Profile will be 
applied. 

 If you want to charge a fixed shipping rate, in the PayPal shipping field, enter the fixed 
amount charged for shipping an order, regardless of the number and weight of purchased 
items. If you leave this field blank and specify the per-item shipping fee (see below), the 
shipping fee will be charged per item. If you leave this field blank and do not specify the 
per-item shipping fee as well, no shipping fee will be charged. 

 If you want to charge a fee for shipping every item in the shopping cart, in the PayPal 
shipping per item field, specify the amount charged for shipping a single item. The total 
shipping fee will be the specified per-item fee multiplied by the number of items in the 
shopping cart. 

Note: The PayPal settings specified in the SiteBuilder Wizard override the respective settings in 
your PayPal Profile! Therefore, if you want to apply the Profile settings, leave the above fields 
blank. 

Now you can go to the Preview tab and see how your online store works in the life context. 
 

 



 Creating Website 57 
 

Previewing and Managing Your Online Store 
Now you can preview your online store and submit a trial order to understand how your store 
works in the live context.  

To preview and try your online store 

1 Open the Preview tab and browse the categories and products at your online store.  

2 Imagine that you are an online shopper. Add items to your shopping cart by clicking Add to 
cart next to the product you want to purchase. Each time you click Add to cart the item is 
added to the shopping cart. 

3 At any time during your shopping, you can view the contents of the shopping cart by 
clicking Your cart at the top of the shop page. In the shopping cart, you can change the 
quantity of selected items. Type the desired quantity in the Quantity field and click Update 
cart. The total sum of your purchase will be updated. To remove an item, select it in the 
Remove column and click Update cart. To remove all products from the cart, click Empty 
cart. 

4 When you finish with your shopping cart, click Shipping to provide customer details. Do not 
forget that now you are acting as an online shopper. If you have already visited this store 
and have an account, enter your user name login and password under For registered users. If 
you are doing this for the first time, under For unregistered users, provide your contact 
information, user login and password to login to the store. SiteBuilder will send the user 
login and password to the customer e-mail address specified in the form. 

Now you, as a store owner, can go to the Users tab and view the user details you have just 
provided. SiteBuilder collects the contact information of registered users and displays them 
on the Users tab. On this tab, you can add user accounts manually or delete them. 

5 After you have submitted your registration form, you will automatically log in to the store. 
Click Shipping again to check out your cart and submit the order. Click I agree. On the next 
screen, check the correctness of your personal information before you submit the order. 
Click I agree again. Your order is submitted. You will receive a confirmation order e-mail at 
the address specified in the user registration form. 
 
After submitting your order you can choose to print out information regarding your 
purchase by clicking Print Version. The screen, displaying the information about your 
purchase, opens. 

 

Figure 40: Purchase Information Print Version 

Now you can print out this information by clicking Print button in your Internet browser (for 
example, in Internet Explorer it is located in the browser command panel under File, or you 
can press CTRL+P keys on your keyboard). 
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If your online store is integrated with the PayPal payment processing system, after you click 
I agree for the first time, a new browser window will open at the PayPal website. You, as a 
shopper, should log in to PayPal (if you have a PayPal user account) or specify your data, 
including the credit card number, e-mail, address and so on. Your payment will be 
processed by the PayPal system. 

Now you, as a store owner, can view the orders in a table on the Orders tab. The table lists a 
unique ID number, date of order creation, date of order update, order status, and the sum of 
the order. To view the order details and change manually the status, click the ID number of 
the order. A new page will open. To change the order status, select the status from the Set 
status for this order list and click Update. To delete this order, click Delete. To return to the 
list of orders, click Back to Order List.  
If your online store is not integrated with PayPal, contact your customers either by phone or 
e-mail and accept payments using other ways, such as cash, cheque, money order or mail 
payments. In this case, you will need to change the order status manually on the Order tab. 

If you have integration with PayPal, all credit card payments will be processed by the 
PayPal service. After a payment is processed, the PayPal system will send an automatic 
payment verification and the order will be assigned the Paid status automatically. All you 
need to do is to check the status of orders on the Orders tab. 

 

Figure 41: Managing E-Shop Orders 

6 Click OK. 

After setting up e-shop properties website owners are enabled to choose to print out information 
about every purchase made in their e-shop.    
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Advanced Editing 
The SiteBuilder WYSIWYG editor automatically converts the textual and tabular information 
on your web pages into the HTML code. HTML is a standardized language for presenting 
information, graphics, and multimedia on the World Wide Web. Using the Advanced Editing 
feature, you can easily apply different styles and change properties of selected elements. 

At the bottom of the Edit page, you can see the Advanced Editing bar displaying the HTML 
structure of the line, on which your mouse cursor is now placed. 

 

Figure 42: Advanced Editing bar 

For example, if you place the mouse cursor in a table, the HTML code structure may contain the 
following tags: BODY, P, TABLE, TBODY, TR, TD. The tag where the cursor is now is shown 
in bold. The child tags of the active tag are enclosed in parentheses.  

To edit the textual content inside a tag 

1 Place your mouse cursor in the line you want to edit and click the tag name in the Advanced 
Editing bar. 

2 Click Advanced in the lower right corner of the Advanced Editing bar. The Advanced Tag 
Properties dialog box opens. 

This dialog box opens for the following tags: P, TR,TD, P(NORMAL), H1, H2, 
H3,H4,H5,H6,ADDRESS, PRE(FORMATTED), A,OL,UL,LI,DIV,SPAN,FONT.  

3 Edit the following properties:  

 Adjust padding properties in the Padding section. 

 Set margins for the text body in the Margin section. 

 Select the color for text and background, and the color and style of borders in the Colors 
and Borders section. 

4 Click OK. The changes will be immediately applied in the editor screen. 

For some tags, such as TABLE, TR (Table Row), TD (Table Data) A (Link), UL (Unordered 
List), OL (Ordered List), HR (Horizontal Rule) and IMG (Image), you can edit properties. The 
set of properties that you can edit is different for each of these tags. 

To edit tag properties 

1 Place your mouse cursor in the line you want to edit and click on the tag name in the 
Advanced Editing bar. 

2 Click Properties on the Advanced Editing bar. The Tag Properties dialog box opens. 

3 Edit the following properties for the tags: 

 For TABLE (Table), you can adjust cell spacing, cell padding, table width and height, 
table and cell alignment, and define the style of borders. 

 For TR (Table Row) and TD (Table Data) tags, you can the width and height of table 
cells and rows and alignment patterns. 
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 For A (Link), you can change the link path, link text, target pages, decoration in the text. 

 For UL (Unordered List), you can change the style of bullets. 

 For OL (Ordered List), you can change the style of numbers in the list. 

 For HR (Horizontal Rule), you can adjust the width and height of the horizontal rule. 

 For IMG (Image), you can edit the image title and alternate text, image width and 
height, and alignment. 

4 Click OK. 

If you are familiar with HTML code, you can insert SiteBuilder icon on any page of your 
website by editing HTML code of this page. 

Here is the example of such HTML code: 

<tr> 

    <td align="center"> <a href="/services.shtml" onclick="javascript: 
goUrl('http://sb.your_domain.net/wizard/index.php')" title="Site Builder — Build your Web 
Site now in 5 simple steps!"><img src="/images/button_sitebuilder.jpg" alt="Site Builder 
&mdash; Build your Web Site now in 5 simple steps!" width="180" height="90" 
border="0"></a> </td> 

  </tr> 
 

Extra Features 
This section describes how to insert meta tags, which will be used by search engines to index 
your future website; set up a password to protect your website from editing by unauthorized 
users; submit your website into search engines; and track users activity on your website. 
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Inserting Meta Tags into HTML Code 
Some search engines, such as Alta Vista, Excite, Lycos, Yahoo and other, use "meta tags" 
embedded in the HTML code in your website to index web documents. Meta tags are inserted 
into the "head" area of your web pages. There are three most common types of meta tags: 
website title (TITLE tag), website description (META DESCRIPTION tag), and website 
keywords (META KEYWORDS tag). 

Though the use of meta tags does not guarantee your web page a top ranking on crawler-based 
search engines, it is a good way for website owners to control how their web pages are 
described by some search engines. Meta tags are useful for additional website promotion with 
some search engines. The SiteBuilder Wizard enables you to easily insert meta tags in the 
HTML code of your website. 

To insert meta tags 

1 On the Extra tab, click Metatags. 

 

Figure 43: Inserting Meta Tags into HTML Code 

2 Enter the name of your website that will be displayed in the title bar of a browser window in 
the Site title field. This title bar is located at the upper left corner of a browser window. The 
website titles are important because they identify your page for users and search engines use 
titles as the primary identifier for listing pages in search results. Therefore, the title should 
be short, unique, and descriptive.  

3 Enter several keywords or phrases separated with a comma, which describe your website 
best in the Site keywords field. Some search engines that support keyword searching will 
index your website using the keywords you provide.  

4 Type a short description of your page displayed by search engines when they hit your 
website in the Site description field. Keep your description short and informative (25-30 
words) or most of your description will be truncated. It is worthwhile to use the meta 
description tag for your pages, because it gives you some control with various crawlers. 

5 Click Apply. 
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Setting Up Password 
When you are creating your website in the SiteBuilder Wizard for the first time, all website files 
are saved in a temporary storage on the SiteBuilder server. From this point of website building, 
all websites are divided into trial websites and regular websites.   

 A trial website is a website with limited functionality. Trial websites cannot be published. 
They are created by users who use SiteBuilder for the first time. 

 A regular website is a website that can be published. Moreover, three additional features, 
Password, SE Submission and Statistics, are available only for regular websites.To update a 
website from trial to regular, follow the instructions on the Publish page or contact your 
SiteBuilder Administrator. 

To set up a password 

1 On the Extra tab, click Password. 

 

Figure 44: Setting Up Password 

2 Enter a password for your website to protect it from editing in the Site password field. This 
password will be used to log into the SiteBuilder Wizard. 

3 Confirm the password specified above in the Site password confirmation field. 

4 Click Apply. 

Note: This feature is available for regular websites only. 
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Submitting Your Website into Search Engines 
Using SiteBuilder SE Submission module, you can easily submit your website information to 
popular search engines.  

Note: This feature is available for regular websites only . 

To submit your website information to a search engine 

1 On the Extra tab, click SE submission. 

 

Figure 45: Submitting Website into Search Engines 

2 Enter the URL of your website, including the http:// prefix, in the Site URL field. 

3 Enter the e-mail of your website in the Site e-mail field. 

4 Select the check boxes corresponding to the search engines to which you want to submit the 
website information. 

5 Click Submit. The information about your website will be submitted to the selected search 
engines. 
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Viewing Statistics 
The SiteBuilder Statistics module enables you to view statistic information and track users 
activities on your website. The module generates more than twenty different reports on various 
categories of statistic data. Using this information, you can track visitors from a statistical point 
of view, which gives you an ability to increase the effectiveness of marketing campaigns and 
improve business processes. For your convenience, the SiteBuilder Statistics module displays 
graphical representations of statistical data, such as linear charts, tables, and pie charts.   

Note: This feature is available for regular websites only . 

To view your website statistics 

1 On the Extra tab, click Statistics. 

 

Figure 46: Viewing Statistics 

2 Select a reporting period from the Period group lists. 

3 Select one of the statistic categories you would like to view using the links on the right side: 
 Attendance statistics includes the following reports: 

 Hits displays the total number of hits on the pages of your website during the reporting 
period.  

 Hosts displays the number of unique users (with unique IP addresses) that visited your 
website during the reporting period.  

 Sessions displays the number of hits on the pages of your website if the time elapsed 
between the two hits exceeded 15 minutes (that is, the duration of an average user 
session is 15 minutes). 
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These reports include hystograms, where the y axis is the number of hits (hosts or sessions) 
and the x axis is hours. Using this information, you can define "peak times" when your 
website was visited by the largest number of visitors. 

 Pages statistics includes the following reports: 
 Popular pages displays the list of the most popular pages of your website. The table 

displays the page name, number of hits on this page, and the percentage of hits on this 
page of the total number of hits on your website. 

 Entry points displays the list of pages on which users enter your website, that is the first 
pages in user sessions. This indicates if users mainly enter through the home page or 
whether they access your website from other pages, possibly through their bookmarks or 
through external incoming links from other websites.  

 Exit points displays the list of pages where users leave your website, that is the last 
pages in users paths.  

 Visit length displays the time (in minutes) users spend on your website. This report 
includes a pie chart and a table, which displays the number of minutes users spend on 
your website. 

 Depth of site visit displays the number of pages users visit during one session.   
 Statistics on user systems includes the following reports presented as pie charts:  

 Operating systems displays the types of operating systems running on user computers. 

 Browsers shows what browsers are used by users to view your website. 

 Screen resolutions shows what screen resolutions are set up on the computers of your 
visitors. 

 Color depths shows what color quality is set up on visitors computers. 

 Cookies usage shows the percentage of visitors who use/do not save cookies. 

 Javascript usage shows the percentage of visitors who have/do not have Javascript 
support. 
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C H A P T E R  5  

Publishing Website 

To publish a website means to copy the web page files to a special directory on a web server.  

To publish a website, click the Publish tab. You will see a link to the temporary storage of your 
website files. Your website is now saved as a trial website in a temporary storage directory on 
the SiteBuilder server. Follow the instructions on this tab on how to publish your website. 
Generally, the procedure is as follows: 

On the Publish tab, you will see an automatically generated website identifier. Using this link to 
the trial website, which might look like http://site_identifier.sitebuilder.hosting_provider.com, 
you can later return to your website, edit it and publish (about editing your website, see the After 
Publishing chapter (see page 67), later in this guide). The password for editing your website is 
the one you have set up on the Extra tab (the Password button in the navigation pane). Change 
the website identifier to some name you can easily remember and click Change My Site Identity. 
To send your website identifier and password at the e-mail address, click Send Site Information 
to Your E-mail.  

4 Purchase hosting services using the link provided on the Publish page. After you purchase 
hosting services from your hosting provider, you will receive a domain name. Tell the 
SiteBuilder Administrator the domain name where your website will be hosted. The 
SiteBuilder Administrator will enter this domain name in the publishing properties for your 
website in the SiteBuilder Administrator Panel.  

5 Enter the link to your trial website in the address bar of a browser. Enter your password in 
the Password field. Your website will open. Click Edit at the top of the page. The 
SiteBuilder Wizard will open. You can either edit the content of your website or go directly 
to the Publish step. Click Publish website. The content of your website will be transferred to 
the server where your website is hosted. After publication, your website will be available on 
the Internet. 

Attention! Be careful when publishing your website because your old files will be 
overwritten with the new files during the publishing process. 

 

 

http://site_identifier.sitebuilder.hosting_provider.com/


 67 
 

C H A P T E R  6  

After Publishing 

It is critical to keep the information on your website up-to-date. You can add news, edit the 
content, and provide information about new products and services. If your website is updated on 
a regular basis, Internet surfers will see that you care about your image on the world wide web. 
Using the SiteBuilder Wizard, you will be able to edit your web pages and add new content. 

You can easily add new pages, edit the old content, and publish your website at any time using 
the SiteBuilder Wizard. 

To edit your website through the SiteBuilder Wizard 

1 Open your website in the SiteBuilder Wizard: 

 You can launch SiteBuilder from the website of your hosting provider and enter your 
website identifier and the password in the authorization screen. 

OR 

 Enter the URL to your website in the address bar of your browser and enter the 
password in the Password field. 

2 Your website will open. At the top of the page, click Edit. The SiteBuilder editor will open 
in the new browser window. 

3 Edit your website: you can change the current design, add new pages, edit the content, insert 
new modules and pictures, and so on. 

4 Open the Publish tab. Click Publish. The new content will be transferred to the location 
where your website is hosted. After the publishing operation is completed, the updated 
website will be available on the Internet. 

Attention! Be careful when publishing your website because your old files will be 
overwritten with the new files during the publishing process. 
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C H A P T E R  7  

Glossary 

BROWSER  

A browser is a software application that lets you access information on the Internet. Browsers 
can read HTML and send HTTP or FTP requests for services on the Internet. Browsers are 
usually associated with the World Wide Web portion of the Internet. 

FTP  

FTP, or File Transfer Protocol, is a method used to transfer files to (upload) and from 
(download) a remote server. You can use the FTP command to: 

 Copy a file from the Internet to your PC 
 Move a file from your PC to the Internet 
 Rename an existing file 
 Delete a file 
 Update an existing file with more recent data 

 

HOST  

In a network, a host is usually a computer that stores software applications and data that may be 
accessed or retrieved by other users. But a host can be any addressable device on the network, 
not just a computer. The host provides services to other computers or users. An Internet Service 
Provider may also be referred to as a Web hosting company. 

HTML  

HTML, or HyperText Markup Language, is a standardized language for presenting information, 
graphics, and multimedia on the World Wide Web. HTML consists of hundreds of codes, tags, 
and symbols that define the type of information and how it should be displayed in a browser. 
HTML is universally understood on a wide variety of platforms. 

IP ADDRESS  

An IP address (Internet Protocol address) is an internal number that identifies a host on the 
Internet or a network. IP numbers are invisible to end users, replaced in your user interface by 
the more familiar domain names and URLs. 

URL  

A URL is a Uniform Resource Locator used to identify an organization or domain on the 
Internet. URLs are standardized names that are typically found on the World Wide Web portion 
of the Internet. URL addresses identify domains on the network. 
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